This PDF document has been produced from the Online Help for
the LMN.

There are a variety of ways you can use it:

Use the Hypertext Bookmarks in the left-hand pane of your
Acrobat Reader as a table of contents and to move around the
material.

Your Acrobat Reader also has a Search facility you can use to
pinpoint relevant material. In addition, each topic in this

document contains hyperlinks (shown in Blue). Click on a link
to jump to another topic. Click on this icon to open notes.

4 ¢
The SPECTRA Line Management Node (LMN) is used to:

¢ Specify the parameters for the survey, the survey lines and enable
shooting.

¢ Define survey specific details such as the GRS, stations and
obstacles

Since much of the information about line positioning may be supplied
before actually starting the survey, you can use the LMN while
disconnected from the Data Server to set up survey data before the
survey starts. This information can be stored in a configuration file
and passed to the Data Server at a later date.

For an overview of the Line Management Node's operation, refer to

the TYPICAL OPERATIONAL FLOW OF THE LMN. For help on a
particular task, refer to the LMN TASK LIST.
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Spectra
This is a pop-up note.
You can move the note around by clicking on the 'Spectra' title bar and dragging.  
Close the note by single clicking on the close button in the top-left corner.


TYPICAL OPERATIONAL FLOW OF THE LMN

The diagram below represents the typical operational flow of the
LMN. Click on the graphics at the left to go to more information about
a particular topic.

Define Project

g, IJse the Project Definition window to enter project identification
e Mo information, details about the type of survey and contractors.
DGEE::E%N The information is used for P2 headers by the Data Logging

RECORDS MHode during the survey .

Define GRSs

Ilze the GRS Editar to define the Geodetic Reference System.
This is defined by a survey and satellite daturn, and data
transformation hetween satellite and survey.

Define Features

Ilze the Feature Editar to define features and their display
parameters. Afeature can he any line or paint vou want to
display. All features are stationary objects, and can he
sumey lines, stations, ohstacles, arinfill lines. A feature
consists of one ar mare coordinate points. Two point
features make up a single segment line, three point
features make up a double segment line, etc.

Set Line Control Parameters

The Line Caontrolwindow allows you to enable or disahle
shooting, choose the next survey line to shoot, and specify
Lead-in and Run-out lengths. You can also define shot
properties such as numbering and distance.

Configure Printing Set-up

The Printing window allows you to choose which details
vou want printed in LMMN Reports. You can choose any
comhbination of Current Line, GRS, Lines, Stations, and
Cbstacles.

Related Information
¢ LMN TASK LIST




LMN TASK LIST

The following tasks are performed within the LMN. Click on a link to
go to a topic with more detail about the task.
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DEFINING THE PROJECT

DEFINING AND EDITING THE GRS

DEFINING A NEW GRS

ADDING COMMENTS TO THE GRS

SPECIFYING THE PROJECTION

DEFINING AND EDITING FEATURES: THE FEATURE EDITOR

DEFINING FEATURE ATTRIBUTES

GROUPING FEATURES

REPEATING FEATURES

USING THE DYNAMIC FEATURE EDITOR

DEFINING POINTS AND SEGMENTS

COPYING AND PASTING FIELDS, POINTS, AND FEATURES

¢ DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW

L4
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SETTING LINE ATTRIBUTES

SETTING AN AIM POINT

SETTING APPROACH AND RUN-OUT LENGTHS
CONTROLLING SHOOTING

SPECIFYING SHOT NUMBERING

SPECIFYING SHOT SPACING

¢ CONFIGURING THE PRINTING SET-UP

Related Information
¢ TYPICAL OPERATIONAL FLOW OF THE LMN




DEFINING THE PROJECT

From the main window of the LMN, select Project Definition from the
Options menu to bring up the Project Definition window. The

information you enter here is used by the Data Logging Node during
the survey for P2/91 and P2/94 headers. Fill in the fields as follows:

¢

* & o o

Project Identifier - this can be any combination of alpha-numeric
characters but should be something that uniquely identifies this
particular project.

Project Name - again, this should be a name which uniquely
identifies this particular project.

Project Start and End Dates - Enter these dates in the form
YYYY MM DD. The End Date field can be left blank if not yet
known and filled in later.

Survey Type and Location - type of survey e.g. 'multi-vessel' and
general location e.g. 'North sea'.

Prepared By - For the logging tape being used, who it was
prepared by (the media label is automatically created by the Data
Logging Node)

Client

Geophysical contractor
Positioning contractor
Processing contractor

Related Information

¢
¢

TYPICAL OPERATIONAL FLOW OF THE LMN
LMN TASK LIST




DEFINING AND EDITING THE GRS

The Geodetic Reference System (GRS) comprises a survey and
satellite datum, and datum transformations between satellite and
survey. The satellite datum is provided to allow externally computed
positions (e.g. satellite latitude and longitude) to be converted to the
survey datum for use within Spectra. You also need to specify the
projection for converting latitude/longitude coordinates to
Easting/Northing. (Please refer to SPECIFYING THE PROJECTION)

If you want to learn more about Geodesy and GRSs, use the
bookmarks on the left of your Acrobat Reader to select a topic from
the Background Information folder.

Note that unless you are opening an existing GRS, and do not wish to
make any changes, you must use the -G option when starting the
Line Management Node in order to be able to access the GRS.

1. From the main window of the LMN, select GRS Editor from the
Options menu to bring up the GRS window.

2. To configure the GRS setup, either:
Open an existing GRS file (via File|Open), or
Define a new GRS setup from scratch (refer to DEFINING A
NEW GRS)

3. Opening an existing GRS file is the usual mode of operation.
The environment variable PN_GRS must have been set to the
directory in which the default GRS files are stored.

4. In both cases you then need to specify the projection required.

Related Information

¢ DEFINING A NEW GRS

¢ SPECIFYING THE PROJECTION

¢ ADDING COMMENTS TO THE GRS




DEFINING A NEW GRS

If there is an existing GRS file, it cannot be overwritten. The
recommended method of operation is to open an existing GRS as
detailed in DEFINING AND EDITING THE GRS. However, you can
define a completely new GRS from scratch if required. You have to
define both datums (satellite and survey) and the datum shift before
specifying the projection.

1. From the main window of the LMN, select GRS Editor from the
Options menu to bring up the GRS window. Usually, the
information to be entered into the fields in this window is supplied
by the exploration company's head office.

If you want to learn more about Geodesy and GRSs, use the
bookmarks on the left of your Acrobat Reader to select a topic
from the Background Information folder.

2. Enter names for the datum definition and spheroid definition in
the Datum Name and Spheroid Name fields respectively. Note
that if you enter the name 'ED50' as the survey datum name, this
triggers the polynomial datum shift.

3. Enter the length of the spheroid Semi-major Axis in metres.

4. Enter the Inverse Flattening of the spheroid, see diagram
below.

b flattening = %

ellipse
inverse flattening = ¢

a = semi-major axis
ithe distance of any point on the equator from the centre of the earth)

b = semi-minor axis
ithe distance of either of the poles fram the centre of the earth)



Spectra
POLYNOMIAL DATUM SHIFT

This refers to the way Spectra converts ED50 GRS to WGS84, and vice versa.  It is only used when these two GRSs are involved.

This is in accordance with the specifications detailed in the document "The transformation between ED50 and WGS84 for exploration purposes in the North Sea" by B.G. Harsson, published by Statens Kartverk, Norway.

In order to trigger the polynomial datum shift, you must enter the name 'ED50' as the survey datum name.  It won't work if you enter any other variant, e.g. ED-50, ED50-UK, etc.  Unless the name is exactly ED50 then coordinates are converted in the usual fashion.

A warning box is displayed on screen to remind you that the polynomial datum shift is in use, and a message appears in the Comments field.


5. Now you need to define the datum shifts used. Enterthe X, Y,
and Z offsets in the appropriate fields. These are the distances
the satellite datum is offset from the survey datum in each plane,
expressed in the current units of length.

6. Enterthe X, Y, and Z rotations in the appropriate fields. These
are the amounts the satellite datum is offset rotationally from the
survey datum, expressed in the current rotational units. There is
a separate value for each plane.

Two rotation conventions are commonly in use, the Bursa-Wolf
model (used in Europe) and the coordinate frame rotation (used
in the USA). They differ in the sign used for all the rotations.
Spectra uses the Bursa-Wolf model throughout.

7. Enter the difference in scale between the satellite datum and the
survey datum (in parts per million) in the Scale Difference field.

8. The Comments field at the foot of the GRS Editor can be used to
enter further information that may be relevant to the GRS set-up.
Alternatively, this field may be automatically populated if you are
using a polynomial datum shift as the survey datum.

More information may be added to the GRS set-up by selecting
Options|View Parameters to display the GRS View window. See
ADDING COMMENTS TO THE GRS for further information.

Related Information

¢ DEFINING AND EDITING THE GRS
¢ SPECIFYING THE PROJECTION

¢ ADDING COMMENTS TO THE GRS



ADDING COMMENTS TO THE GRS

You can add comments and/or further information to the GRS that
may be relevant to the set up.

1. From the main window of the LMN, select GRS Editor from the
Options menu to bring up the GRS window.

2. Choose View Parameters from the Options menu of that
window to bring up the GRS View window.

3. Enter or edit comments in the main field of this window and click
OK when you are finished.

Note that this window is automatically filled if you have chosen to
use a polynomial datum shift and this information will overwrite
any other comments you may enter.

Related Information

¢ DEFINING AND EDITING THE GRS
¢ DEFINING A NEW GRS

¢ SPECIFYING THE PROJECTION


Spectra
POLYNOMIAL DATUM SHIFT

This refers to the way Spectra converts the ED50 GRS to WGS84, and vice versa.  It is only used when these two GRSs are involved.  

This is in accordance with the specifications detailed in the document "The transformation between ED50 and WGS84 for exploration purposes in the North Sea" by B.G. Harsson, published by Statens Kartverk, Norway. 

In order to trigger the polynomial datum shift, you must enter the name 'ED50' as the survey datum name.  It won't work if you enter any other variant, e.g. ED-50, ED50-UK, etc.  Unless the name is exactly ED50 then coordinates are converted in the usual fashion.

A warning box is displayed on screen to remind you that the polynomial datum shift is in use, and a message appears in the Comments field.


SPECIFYING THE PROJECTION

This should be done AFTER you have defined the GRS. (Please
consult DEFINING AND EDITING THE GRS) The Projection is used
to convert latitude/longitude coordinates to the grid Easting/Northing
coordinates. This information is not held in the GRS file.

If you want to learn more about Geodesy and different types of
Projections, consult the BACKGROUND INFORMATION: MAP
PROJECTIONS topic.

1. From the main window of the LMN, select GRS Editor from the
Options menu to bring up the GRS window.

2. From the GRS window, select Projection from the Options
menu to bring up the LMN Projection window.

3. Select a projection type, using the pop-up menu at the top of the
window. Choose from:
Transverse Mercator
Mercator
Stereographic
New Zealand Grid
Lambert 1
Lambert 2
RSO
UTM

4. Depending on your selection, different fields are enabled in the
LMN Projection window.

For U.T.M. projections select the required hemisphere (North or
South) using the Hemisphere pop-up menu and enter the zone
number in the UTM Zone field. (UTM Zone numbers are listed

by the United States Geological Survey. Southern Hemisphere

zone numbers are negative.)

For other projections enter the Latitude and Longitude of the




projection’'s origin. Alternatively, enter the Northing and Easting
of the projection's origin (in current length units). Enter the Scale
Factor for the projection.

For Lambert 1 and 2 projections enter the 1° parallel in degrees.
For Lambert 2 projections only, also enter the 2" parallel in
degrees.

For RSO projections enter the Initial bearing and the Skew angle
in degrees.

Provided you started the LMN with the -U option, you can use
the Grid Units pop-up menu to set the grid units to Metres,
Feet, US Feet, or Custom units. The appropriate column
headings in the Display Node display which units are active. If
you did not use the -U option, the grid units are set to metres and
the Grid Unit setting controls do not appear in this window.

Refer to the Spectra Software Installation and Set Up manual for
full details of all command line arguments.

Related Information

¢

¢
¢
¢

BACKGROUND INFORMATION: MAP PROJECTIONS
DEFINING AND EDITING THE GRS

LMN TASK LIST

TYPICAL OPERATIONAL FLOW OF THE LMN



DEFINING AND EDITING FEATURES: THE FEATURE EDITOR

A feature consists of either a point (such as a rig, base station, etc.),
or a series of two or more points which together define a line. Two
point features make up a single-segment line, three point features
make up a double-segment line, etc. Each segment of a line
connects two points.

You can import feature definitions from another LMN file by
appending it to the end of the one you are currently working on. See
APPENDING ANOTHER LMN FILE for details.

All features are stationary objects, and can be categorised as:

Survey Lines These are line to be shot during the survey,
and make up the prospect.

Stations These are radionav stations and are single
point features. The coordinates of these
features are used to construct observations
(within the Spectra Configuration Node).

Obstacles These single or multi-point features are
primarily used by the Display Node. They
can be any fixed object.

To bring up the Feature Editor window, select Feature Editor from the
Options menu of the main window of the LMN.

The Feature Editor is divided into three main sections: the main
control area (at the top of the window) where you define feature
attributes, the point definition area (in the middle), and the segment
definition area (at the bottom). Generally, you would start by
DEFINING FEATURE ATTRIBUTES. Alternatively, select a specific
task from the main LMN TASK LIST.

Related Information
¢ DEFINING FEATURE ATTRIBUTES
¢+ APPENDING ANOTHER LMN FILE




¢ GROUPING FEATURES
¢ REPEATING FEATURES
¢ DEFINING POINTS AND SEGMENTS



APPENDING ANOTHER LMN FILE

You can append features from another LMN file to the one you are
currently working on.

From the main window of the LMN, select Feature Editor from
the Options menu to bring up the Feature Editor.

From the File menu of the Feature Editor, select Append to
bring up a standard File Select window.

Select the LMN file containing the features you wish to append to
the end of your existing file. Features can only be appended
from another LMN file.

Note that if any feature names are duplicated between your
existing file and the file to be appended then those features are
not appended.

If required you can now edit these features as described in
DEFINING AND EDITING FEATURES: THE FEATURE
EDITOR.

Related Information

¢

¢
¢
¢

TYPICAL OPERATIONAL FLOW OF THE LMN

LMN TASK LIST

DEFINING AND EDITING FEATURES: THE FEATURE EDITOR
DEFINING FEATURE ATTRIBUTES




DEFINING FEATURE ATTRIBUTES

In the main control area of the Feature Editor (Options|Feature Editor
from the main window) you can define new features or edit existing
ones.
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A list containing all of the current features is displayed to the right in
the Features list box. Use the scroll bar to view the whole list.
Enable the Sort button to rearrange the list into alphabetical and
numerical order. Use the pop-up View menu to specify the sort of
features you want to see listed to make the list more manageable.
The default type is All.

1. To define a new feature select Feature|New from the Edit menu
of the Feature Editor. Enter a new name in the Feature Name
field and select a Feature Type from the pop-up menu. The
default type is Survey Line. For survey lines, the Line Number
field displays the line number, otherwise the field is inactive.

To edit an existing feature, double-click on its name in the
Features list box, or enter the name in the Feature Name field,
to display its attributes in the other fields.

2. Define the coordinate system and units of measurement in which
the feature data items are displayed by using the pop-up menus
in the Display Parameters section:
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First, select the coordinate system using the Coords pop-up
menu. This determines the coordinates in which the features
are displayed. Your choice is reflected in the coordinates used
in the point definition area. Select Survey Lat-Long to use the
survey latitude/longitude coordinate datum. Select East-North to
use Northing and Easting values for the coordinates rather than
latitude and longitude. The default is Survey Lat-Long. If you
started the LMN with the -G parameter, you also have the option
of Sat Lat-Long which activates the satellite latitude/longitude
coordinate datum.

The navigation mode is shown on the Lines label. It can be
Great Circle, Grid, Grid True, or Rhumb mode and reflects
whichever choice you applied when SPECIFYING SHOT
SPACING in the Line Control window.

Select the units in which angles are displayed using the Angles
pop-up menu. Choose between Degrees and Radians. The
default is Degrees.

Whatever you specified for Grid Units in the Projection window is
reflected here by the Distances label. (The Projection window
is accessed via the Options menu of the GRS window.)

Select the format in which geographical coordinates are to be
entered and displayed. Use the Geogs pop-up menu to choose
between:

DDMMSSsss for degrees, minutes, seconds and decimal
seconds.
DDMMmmmmm for degrees, minutes and decimal minutes



DDddddddd for degrees and decimal degrees
The default is DDMMSSSsss.

7. For a radionav station, specify any delay associated with the
feature. Enter a value in the Fixed Delay field, in station pattern
units. This information is used when defining observations (in
the Spectra Configuration Node).

Related Information

¢ DEFINING AND EDITING FEATURES: THE FEATURE EDITOR
¢ GROUPING FEATURES

¢ REPEATING FEATURES

¢ DEFINING POINTS AND SEGMENTS



GROUPING FEATURES

Within the LMN's Feature Editor you have the option to assign
features to different logical groups, for example 'rigs’, 'lines’, etc. This
Is of use primatrily in the Display Node where you can apply display
configuration properties to these groups of features instead of
individually.

1. From the main window of the LMN, select Feature Editor from
the Options menu to bring up the Feature Editor.

2. From the Feature list, select the feature you want to be part of a
group.

3. Specify an existing feature group by selecting Options|Select
Group to bring up a list of defined groups. If no groups have yet
been defined, this window is empty and you must define a new
group (see step 4).

4. To use a group, select it from the list and Apply (or OK).
Alternatively, enter the group name directly into the Feature
Group field.

5. To define a new group and assign the feature to it, select the
feature and enter the new group's name in the Feature Group
field. Whatever groups you define are then added as options to
the Group Select window.

Related Information

¢ DEFINING AND EDITING FEATURES: THE FEATURE EDITOR
DEFINING FEATURE ATTRIBUTES

REPEATING FEATURES

APPENDING ANOTHER LMN FILE

DEFINING POINTS AND SEGMENTS
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DEFINING POINTS AND SEGMENTS

Each feature defined in the LMN consists of at least a single point
(such as a rig, base station, etc.), or a series of two or more points
which together define a feature in terms of line segments connecting
the points.

Use the point and segment definition areas (the central and lower
portions of the Feature Editor) to define either the coordinates of a
single point feature, or individual points on a line plus the line
segments which connect them. These areas are divided into
subsections, showing three points at a time, plus the (two) line
segments connecting them.
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Use the horizontal scroll bar to move forwards and backwards
through the points and line segments, always showing three points
and their two connecting line segments at a time.

The points and segments areas behave interactively. When entering
the point coordinates, the line segment's data is calculated and
shown in their respective fields. Editing a point's coordinates causes
the rest of the points to be recalculated accordingly.

1. Define the individual points on the line. You may create as many
points as required for the feature (using Edit|Point|New), and
delete any unwanted points (using Edit|Point|Delete).

You can view and edit three points at a time using the fields in
the point definition area. Remember that if segments have
already been defined, there may be data already in the point




coordinate fields - if this data is changed the segment data is
recalculated and updated accordingly.

Points are defined via the following fields:

Point Number  This identifies which point you are editing.
This field is purely for information and is not editable.

Latitude  This is the latitude or Northing (depending on the
coordinate system selected in the main control area) of the point
you are editing. To move the point, type a new coordinate in this
field. A Northing is expressed as a decimal number. A latitude
Is expressed in the format selected from the Geogs pop-up
menu.

Longitude This is the longitude or Easting (see above,
substituting longitude for latitude and Easting for Northing).

HeightThis is the height of the current point above geoid
(expressed using the length unit selected in the main control
area). To change the height, enter a new value in this field.

Locked This switch determines whether the point can be
changed automatically in response to changes in other parts of
the line. If it is left disabled (the default) for a point, a change
made to another point causes this point to be updated
accordingly. If it is enabled, the point is not updated
automatically when other points are changed. It is not possible
to lock more than one point or segment for any one feature.

To save time: You can save a lot of repetitive work by using the
Feature Editor's Edit menu options to add new points and copy
and paste point definitions. Please refer to COPYING AND
PASTING FIELDS, POINTS, AND FEATURES for detalils.

To delete an unwanted point, select one of that point's fields,
then select Edit|Point|Delete. If you do not select a point's field
before using Edit|Point|Delete, the point with the highest Point
Number is deleted.



Define the line segments which connect individual points on a
line, using the segment definition area. The segments shown
are those connecting the points shown in the point definition
area. Remember that if the point coordinates have already been
defined, there may be data already in the segment fields - if this
data is changed the point coordinate data is recalculated and
updated accordingly.

Segments are defined by the following fields:

Length This is the length of the segment (in the distance
units selected in the main control area).

Locked This switch determines whether the segment can be
changed automatically in response to changes in other parts of
the line. Ifitis enabled (i.e. locked), the segment cannot be
changed automatically. If you leave it disabled (the default) it
means that changing one end point of the segment automatically
changes the other end point so that the length and direction of
the segment remain the same. It is not possible to lock more
than one point or segment for any feature.

Bearing This is the direction of a straight line segment.

Related Information
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DEFINING AND EDITING FEATURES: THE FEATURE EDITOR
DEFINING FEATURE ATTRIBUTES

GROUPING FEATURES

REPEATING FEATURES

COPYING AND PASTING FIELDS, POINTS, AND FEATURES
APPENDING ANOTHER LMN FILE



COPYING AND PASTING FIELDS, POINTS, AND FEATURES

Defining every feature, point, and segment in the survey individually
from scratch in the Feature Editor would involve a lot of repetitive
work - avoid this by using the various copy and paste options
contained in the Edit menu. Also see REPEATING FEATURES.

Copying and Pasting a point
To copy data from one point into another point:

1. From the Features list, select the feature from which you wish
to copy a point and select the point by placing the cursor in a
field of the point's definition area. Select Edit|Point|Copy to copy
the contents of the point to memory.

2. Select the feature to copy the point to (using the Features list).
If you are copying to another point within the same feature, omit
this step.

3. Place the cursor in a field of the required point in the point's
definition area. Select Edit|Point|Paste. This pastes the copied
data from memory into the selected point.

Replacing a feature/Editing an existing feature

1. Select the feature to edit or replace in the Features list. Either
edit the fields/menus as desired or, to replace the feature, select
Edit|Feature|New.

2. If you have made changes to the current feature before
attempting to replace it, without applying the changes, a
message is displayed warning you that 'Current feature has been
changed since saved. All changes will be lost unless saved.'
There is a choice of three responses to this - Apply, Discard, or
Cancel. Either Apply the changes to the current feature before
replacing it with a new one, Discard the changes and replace the




feature with a new one, or Cancel the command to replace the
current feature.

Feature Names must be unique. If you change the name of the
current feature to a duplicate of a defined feature, when you
apply the changes a warning message is displayed warning you
that the 'Given feature name is already in use'. You should enter
a new, unique name for the feature in the Feature Name field to
correct the problem.

Copying a feature

To make the current feature a copy of an existing feature:

Select the feature to copy in the Features list. Select
Edit|Feature|Copy. The current feature is now a copy of the
selected feature, with only the Feature Name field left blank.

Enter a new name for the feature in the Feature Name field
before clicking Apply.

Related Information

¢
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DEFINING AND EDITING FEATURES: THE FEATURE EDITOR
GROUPING FEATURES

REPEATING FEATURES

DEFINING POINTS AND SEGMENTS

APPENDING ANOTHER LMN FILE



REPEATING FEATURES

This primarily used for specifying survey lines but can be used to
repeat any feature.

To make a specified number of repetitions of an existing feature:

1. From the main window of the LMN, select Feature Editor from
the Options menu to bring up the Feature Editor.

2. Select the feature to repeat in the Features list. Select
Edit|Feature|Repeat to display the Feature Repeat window.

Alternatively, call up the Feature Repeat window first by
selecting Edit|Feature|Repeat. Then type the name of the
feature to be repeated in the Feature Name field.

3. Enter the basis for the name of the repeated feature in the
Repeat Name field. For example, if you enter EastCoast then
repetitions of the feature will be named EastCoast00001,
EastCoast00002, etc, up to EastCoast0000n, where n is the
value you enter for Repeat Count (see below).

4. Specify the number of times to repeat the feature in the Repeat
Count field. The default value is 1. You can enter any positive
integer value.

5. Indicate whether or not the repeated feature is to constitute
parallel lines, using the Parallel Lines button. If the button is on
(highlighted), the Offset Range defines the separation between
the parallel lines. If you select Parallel Lines, the Offset Bearing
Is inapplicable and the field is greyed out.

6. Enter the range offset to be successively applied for each
repetition, in the Offset Range field.




Enter the bearing offset to be successively applied for each
repetition, in the Offset Bearing field. Note that if you turn on
the Parallel Lines option, this option is inapplicable and the field
IS greyed out.

Apply the repeated feature definition.

You can repeat this process for any other features you wish to
repeat before closing the Feature Repeat window.

Related Information

¢
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DEFINING AND EDITING FEATURES: THE FEATURE EDITOR
GROUPING FEATURES

DEFINING POINTS AND SEGMENTS

COPYING AND PASTING FIELDS, POINTS, AND FEATURES
APPENDING ANOTHER LMN FILE



USING THE DYNAMIC FEATURE EDITOR

The Dynamic Feature Editor is used to enter details of obstacles
encountered during the course of the survey. It supplies the current
vessel position and allows you to enter feature details relative to that
position. The feature can have only one point since it must be a
stationary obstacle.

However, another use for the Dynamic Feature Editor is creating a

test line. You may want to do this if, for example, you are on a line

change and do not want to alter the vessel's course but want to test
the systems in a real shooting situation. Please refer to the second
section in this topic for details of how to create a test line.

Defining a Stationary Obstacle:

1. From the main window of the LMN, select Feature Editor from
the Options menu to bring up the Feature Editor.

2. Select Dynamic from the Options menu of the Feature Editor to
show the Dynamic Feature Editor window.

The current vessel position is shown in the Current Latitude
and Current Longitude fields. These fields read No solution
data if the LMN is not receiving data from the NCN and nothing
you enter in any of the fields will be applied in that case.

Provided the position fields are populated, the position is
updated dynamically until you fill in the other fields, at which
point it stops updating.

3. Enter the range and bearing of the obstacle from the current
vessel position in the Range Offset and Bearing Offset fields.
Enter a name for the feature in the Feature Name field.

4. Click OK and the feature is added to the Feature list on the
Feature Editor.




Creating a Test Line
(Points 1 and 2 as above.)

3. Enter 0 in both the Range Offset and Bearing Offset fields and
enter a name for your test line in the Feature Name field. The
Current Latitude and Current Longitude fields should reflect
the vessel's current position.

4. Click OK to return to the Feature Editor.

5. Change the selection in the Feature Type menu from Obstacle
to Survey Line.

6. Lock the first point by enabling the Locked checkbox
underneath the point definition for Point Number 1.

7. Enter the desired length of the test line in the Length field.

8. Enter the CMG (the direction in which the vessel is travelling) in
the Bearing field. (You can ascertain the CMG from the
Vessels Display of the Display Node.)

9. Apply the feature definition. This creates the second point for
you automatically.

10. Click OK then, from the main, window Submit.

The newly created test line can now be selected and controlled
from the Line Control window as the line the vessel is currently
travelling along.

Related Information
¢ DEFINING AND EDITING FEATURES: THE FEATURE EDITOR
¢ TYPICAL OPERATIONAL FLOW OF THE LMN



DEFINING LINE CONTROL PARAMETERS: THE LINE CONTROL
WINDOW

Access the Line Control window by selecting Line Control from the
Options menu of the LMN's main window.

This displays the line attributes for the currently selected line, as well
as general information relating to the line. Use it to set up current line
information, define and start the current line, put in a long shot
interval if required, and control shooting.

The Line Control window comprises six separate areas. Click on one
of the links below to go to help for each area.

SETTING LINE ATTRIBUTES

SETTING AN AIM POINT

SETTING APPROACH AND RUN-OUT LENGTHS
CONTROLLING SHOOTING

SPECIFYING SHOT NUMBERING

SPECIFYING SHOT SPACING

®* & & o oo o

Note that whenever you apply changes from here all the details on
the Line Control window are saved to a . CLF file in the data
directory. When you use the fi | enane. LMN configuration file, the
line name stored in the associated f i | enanme. CLF is used.

WARNING: When the LMN is closed down, or in the event of a
crash, the line control parameters as defined via the Line Control
window are saved to file, even if they have not been saved properly
via File|Save. On restarting, these parameters are loaded back into
the LMN. Thus, if shooting was enabled at the time of shutdown it
will be enabled at start-up, and vice versa.

Related Information
¢ TYPICAL OPERATIONAL FLOW OF THE LMN




SETTING LINE ATTRIBUTES

The Line Attributes panel (top left of the Line Control window)
displays the current line and its bearing (or azimuth).

1. From the main window of the LMN, select Line Control from the
Options menu to bring up the Line Control window.

2. To change the name of the line, as set up in the Feature Editor,
enter a new name in the Name field. The number in the small
field to the right of the Name field contains the sequence
number associated with that line as set up in the P2 file.

3. To change the current line, right-click in the Name field or
choose Select from the Options menu to display the Line
Selection window. The Items panel lists all currently defined
lines. Use the scroll bar to see the complete list. When on line,
the current line is highlighted on the list, and shown in the
Selection field. Select the line required by either double-
clicking on its name, selecting the name and clicking OK, or
entering its name in the Selection field and clicking OK.

4. To reverse the current line select Reverse|Current Line from the
Options menu. This causes the lead-in and run-out sections to
be switched to the opposite ends of the line. You can only use
this option before reaching the lead-in stage.

5. Select Reverse|Aimpoint to reverse the line associated with the
aimpoint. Refer to SETTING AN AIM POINT for more details
about aim points.

6. The Start and End fields display the start and end points of the
currently selected line, in whatever coordinate system is
specified in the Feature Editor. These details cannot be edited
from this window.




The Bearing or Azimuth field displays the current line bearing.
This value changes according to which section of the line is
current (e.g. for dog-legs etc). It cannot be edited here, but is set
when you define the survey line using the Feature Editor. The
label changes between bearing and azimuth depending on the
method of shot spacing specified. It reads azimuth if Great
Circle or Rhumb are selected and bearing if Grid or Grid True
are selected.

Related Information

¢

¢
¢
¢

SETTING AN AIM POINT
SPECIFYING SHOT SPACING
DEFINING AND EDITING FEATURES: THE FEATURE EDITOR

DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW



CHANGING THE CURRENT LINE

By default, when you enter the Line Control window, the current line
details are shown if you are on line.

To change the line shown:

1. Right-click in the Name field or choose Select from the Options
menu to display the Line Selection window. The Items panel
lists all currently defined lines. Use the scroll bar to see the
complete list. The current line is highlighted on the list, and
shown in the Selection field.

2. Select the line required by either double-clicking on its name,
selecting the name and clicking OK, or entering its name in the
Selection field and clicking OK.

Related Information
¢ SETTING LINE ATTRIBUTES

¢ DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW




SETTING AN AIM POINT

If you wish, you can specify an aim point.

1. From the main window of the LMN, select Line Control from the
Options menu to bring up the Line Control window.

2. Right click in the Feature to use field to bring up the Target
Select window where you can choose from a list of defined
features. Use the scroll bar to view the whole list and select a
feature by either double-clicking on its name or selecting it and
clicking OK.

If the line you select as the Feature to use is the current line,
when a new current line is selected, the Feature to use field
changes to match it. This does not happen if any other feature is
selected as the Feature to use.

3. Use the Mode pop-up menu to select the coordinate mode in
which to display the separation of the point from the vessel,
choosing between Polar and Rectangular coordinates. Also, use
the Relative to pop-up menu to specify whether the separation
coordinates are to be shown relative to North or relative to the
Line Bearing (the default).

The X ordinate (or Range) and Y ordinate (or Bearing) of the
selected point from the vessel's reference point are displayed in
the last two fields in this section of the window. An alphanumeric
display of range and bearing to aim point can be shown using
the Display Node.

Related Information

¢ DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW

¢ SETTING LINE ATTRIBUTES




SETTING APPROACH AND RUN-OUT LENGTHS

Approach and run-out lengths refer to distances directly at the start
and end of the line. On approach, the guns start firing test shots
before the line proper to allow an opportunity to check everything is
functioning properly. At the end of the line, the guns continue firing
for the number of shots specified as the run-out, usually until the first
half of the streamers has passed over the end of the line. Approach
and run-out lengths are always on the same bearing as the line itself.

Approach Run-out

1. From the main window of the LMN, select Line Control from the
Options menu to bring up the Line Control window.

2. The Approach and Run-out section is situated in the lower left
portion of the window.

Enter the Approach and Run-out lengths as numbers of shots.
You can alter the run-out length any time before the end of the
line is reached. Enter a zero in the Run-out field if no run-out is
required.

Related Information

¢ DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW

¢ SETTING LINE ATTRIBUTES
¢ LMN TASK LIST




CONTROLLING SHOOTING

Shooting is enabled and disabled from the Line Control window.

1. From the main window of the LMN, select Line Control from the
Options menu to bring up the Line Control window.

The Shot Control section is situated in the top right portion of the
window.

2. Select a shot control method from the Mode pop-up menu.

Choose On Line to shoot when on line, but not during approach.
This means that during approach, shot closures are not issued
from the RTNU, and automatic shots are generated internally by
the RTNU, to stop guns firing. Shooting starts automatically
when the vessel is on line, providing the Shot Control button is
ENABLED.

Choose On Line & Approach to shoot when on line and during
approach: shooting commences automatically when the vessel
reaches the approach area, providing the Shot Control button
is ENABLED. If you wish to inhibit individual triggers on
approach when in this mode, enable the Online Only checkbox
for those triggers in the RTCN's O/P Trigger Editor.

3. The Shot Control button, when depressed, enables shooting
and displays ENABLED. When released, the button disables
shooting and displays DISABLED.

When you press the Shot Control button, you are asked to
confirm if you really want to enable/disable shooting and this
confirmation acts as a submit. Remember to apply the line
control definition before enabling shooting.




Related Information

¢ DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW



SPECIFYING SHOT NUMBERING

1. From the main window of the LMN, select Line Control from the
Options menu to bring up the Line Control window.

The Shot Numbering section is situated in the middle right
portion of the window.

2. Enter the number of the first shot at the start of the line in the
Line start field. The Line start can be any valid shot number.

In the Step field, to the right of the Line start field, enter a
number to define the shot increment. If, for example, you
entered a Step of 3 and a Line start of 1, then the shot
numbering would be 1, 4, 7, 10, etc. Note that you can enter a
negative shot increment for count-down shot numbering.

3. The first shot number at the start of approach (Approach start) is
calculated automatically (from the Line start and Approach length
values specified - see above and SETTING APPROACH AND
RUN-OUT LENGTHS).

Alternatively, to specify this manually, enable the check box next
to the Approach start field to enable the field, then enter the
required shot number. This can be any valid shot number.

4. The shot number at which automatic shooting starts (Actual shot
start) is calculated automatically (from the Line start and
Approach length values specified, and the shot control Mode
selected - see above, SETTING APPROACH AND RUN-OUT
LENGTHS, and CONTROLLING SHOOTING).

Alternatively, to specify this manually, enable the check box next
to the Actual shot start field to enable the field, then enter the
required shot number. This can be different from the Line start
shot number if, for example, you previously shot part of a line
and now wish to resume shooting where you left off.




5. The Line end shot field displays the shot number of the end of
the line. If you enable the check box to the right of the field, the
label changes to Actual end shot and the field becomes active.
This is used if you only want to shoot part of a line.

6. You can move the shooting reference point back or forth by
entering an adjustment value in the Shot Layback field. For
example, a value of 20 moves the reference point 20 metres
forward; a value of -20 moves the reference point 20 metres
backward.

Related Information

¢ DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW

¢ SETTING APPROACH AND RUN-OUT LENGTHS
¢ CONTROLLING SHOOTING



SPECIFYING SHOT SPACING

1. From the main window of the LMN, select Line Control from the
Options menu to bring up the Line Control window.

The Shot Spacing section is situated in the lower right portion of
the window.

2. Specify the Shot Spacing mode by choosing an option from the
left-hand pop-up menu. Select either Grid, Great Circle, Grid
True, or Rhumb calculation mode.

The shot spacing mode controls the way line calculations are
performed. In both Grid and Grid True modes, the line is a
straight line in the projection, i.e. what you see if you draw a
straight line between the points on a chart. In Great Circle mode
the line is the curve on the spheroid of shortest length between
the points. Rhumb uses the path between the points which
crosses each meridian at the same angle.

Grid and Grid True modes differ in the way preplots are
computed and in the meaning of Dalong and Doff coordinates.

In Grid mode, the preplot shot points are a constant grid distance
apart (i.e. on a chart they appear a constant distance apart).
Similarly, in Grid mode, Dalong and Doff are in grid metres, while
in Grid True mode they are in true metres. In Great Circle and
Rhumb mode the preplots are a constant true distance apart,
and Dalong and Doff are also in true metres.

The choice you make here is reflected in the Feature Editor
Display Parameters section (see DEFINING FEATURE
ATTRIBUTES), on the Lines label.

3. Specify the approach and line shot spacing by selecting DAlong
Track, Cycle Test, Time, or Time Dual from the pop-up menu on
the right and entering a shot spacing or time value.

Note: Both the Approach and Run-out and Shot Numbering




sections are updated as the shot spacing mode is changed.

DAlong Track

For this method of shot spacing, enter a shot spacing value, x (in
metres), in the Metres field. This causes a shot to be fired
every X metres along the lead-in and line, irrespective of the
distance the vessel actually travels if it is not tracking true to line.
For example, if the vessel is following a zig-zag course back and
forth across the lead-in or line, and you enter a value of 25
metres, shots are fired every 25 metres along the lead-in or line,
and not every 25 metres the vessel travels.

There is also a facility which allows you to specify shot intervals
per segment when on a multi-segment line in DAlong Track
mode. If these conditions are met, extra fields appear.
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The current segment number is displayed and the value in the
Metres field applies to the shot spacing for that segment. The
arrows can be used to increase and decrease the segment
number.

Cycle Test

For this method of shot spacing, enter a shot spacing value, x (in
seconds), in the Seconds field. This causes a shot to be fired
every x seconds along the lead-in and line, irrespective of the
distance the vessel has actually travelled.

Time

For this method of shot spacing, the value entered in the Metres
field controls the shot spacing for lead-in while the value entered
in the Seconds field controls the shot spacing for line.

Enter a shot spacing value, x (in metres), in the Metres field.
This causes a shot to be fired every x metres the vessel travels



irrespective of the distance actually made good along the lead-in.
For example, if the vessel is following a zig-zag course back and
forth along the lead-in, and you enter a value of 25 metres in the
Metres field, shots are fired every 25 metres the vessel travels
and not every 25 metres along the lead-in.

Enter a shot spacing value, x (in seconds), in the Seconds field.
This causes a shot to be fired every x seconds the vessel travels
along the line, irrespective of the distance the vessel actually
travels.

Next Shot Offset

This option is available in Time mode only. This feature enables
you to put in a long shot interval during a line. You may want to
do this if, for example, another survey vessel is shooting close
enough to clash with your vessel's own shots. Enter a value in
seconds in the Next Shot Offset field and click Submit. The
NCN reads this value and uses it to delay the time of the next
shot prediction (not the one it is currently predicting). The offset
Is used for one shot only and resets to zero once it has been
submitted.

Time Dual

This method of shot spacing is intended to provide a method of
synchronising shooting between master and slave vessels when
there is no radio link between them.

When you select the Time Dual method of shot spacing, the SOL
field displays the predicted time of the first shot on line and
updates it on Approach. The predicted time becomes more
accurate the closer you are to the start of line.

On the master vessel, monitor the SOL prediction and, at the
desired time, enable the check box to the right of the field. You
can now edit the contents of the field if you wish. Submit the
LMN configuration to the Data Server and telephone the slave
vessels to tell them the fixed time of the SOL. They should then
also enable the same checkbox on their systems and enter the
same fixed time. This ensures that all vessels in the survey have



the same predicted time for SOL. All vessels should now fire
their first, and subsequent shots at the same time (+/- 50ms).

Related Information

¢

DEFINING LINE CONTROL PARAMETERS: THE LINE
CONTROL WINDOW

SETTING LINE ATTRIBUTES
SPECIFYING SHOT NUMBERING
SETTING APPROACH AND RUN-OUT LENGTHS



CONFIGURING THE PRINTING SET-UP

If required, configure the Node's printing set-up. If you do not
perform any configuration, the LMN prints full details of: The Current
Line, GRS, Lines, Stations, and Obstacles, along with a cover sheet
giving the Project name, ID, Client and Contractor.

1. From the main window of the LMN, select
Options|Printing|Configuration to bring up the Printing window.

2. Enable printing of details by enabling/disabling the appropriate
buttons. Choose any combination of Current Line, GRS. Lines,
Stations, and Obstacles.

You can initiate printing according to this set-up at any time by
selecting Options|Printing|Start Printing from the main window of the
LMN. This sends a Postscript file to the laser printer.

Related Information
¢ TYPICAL OPERATIONAL FLOW OF THE LMN
¢ LMN TASK LIST




LMN FILE FORMAT

The .LMN configuration file contains descriptions of all the features
defined using the LMN. LMN files are ASCII files with fields
separated by TABs and CRLF characters used to terminate sections
within the file. In the lists below, each field is followed by a TAB
unless otherwise indicated.

In this file format, GRSs are referred to as PSDs, the survey datum is
called the standard datum and the satellite datum is called the
alternate datum.

The main sections of the file define:

Default values

PSD information for the standard PSD
PSD information for the alternate PSD
Shot conventions

Feature definitions

Project information

Current line information

Aim point information

Run-in information

GRS file name

Printing setup information
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These sections appear in the file in the above order, and their field
descriptions and types are as listed in the following sections.

Defaults

CRLF
"defaults” STRING
Angle units STRING default is "degrees"



Spectra
 

Spectra
Angle unit options are:
"degrees" (default)
"minutes"
"seconds"
"ddmmss"
"radians"


either
Length units

or (if custom units defined)
"custom"

Unit name

Unit length

then
Default lead-in length
Default run-out length

STRING

STRING
STRING
NUMBER

NUMBER
NUMBER

default is "metres"

then the default shot spacing information for lead-in:

Spacing type
Spacing value

...and for straight line segments:
Spacing type
Spacing value

...and for curved line segments:
Spacing type
Spacing value

followed by:
CRLF

PSD information (standard PSD)

"std_psd"”

followed by datum information:
Datum name

dX

dy

dz

rx

ry

rZ

ds

followed by spheroid information:
Spheroid name

Semi-major axis

Inverse flattening

followed by projection information:

Projection name

STRING
NUMBER

STRING
NUMBER

STRING
NUMBER

STRING

STRING

NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER

STRING

NUMBER
NUMBER

STRING

default is "along_track" @

default is "along_track"

default is "along_track"
(not followed by TAB)


Spectra
Spacing type options are:
"along_track" (default)
"in-place"
"time"
"velocity"
"distance"
"angle"

Spectra
Length units options are:
"metres" (default)
"kilometres"
"miles"
"naut_miles"
"feet"
"custom"


Scale factor
Latitude
Longitude
Easting
Northing
Projection type

plus, for Lambert 1 & 2 projections:

First parallel

and, for Lambert 2 projections:
Second parallel

plus, for RSO projections:
Initial bearing

Skew angle

followed by:

CRLF

PSD information (alternate PSD)

"alt_psd"”

NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
STRING

NUMBER

NUMBER

NUMBER
NUMBER

STRING

degrees
degrees

degrees
degrees

followed by the same fields as for the standard PSD.

Shot conventions

"shot_conv"

Lead-in start

Lead-in change

Line start

Line change

Number to add for reshoot
Partial or full line indicator
CRLF

Feature definitions
Repeated for each defined feature.

Polyline definition:
"polyline™

Feature name

Feature representation

then, for each point in the feature:
Latitude
Longitude

STRING

NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
STRING

STRING
STRING
NUMBER

NUMBER
NUMBER

(not followed by TAB)


Spectra
Projection type options are:
"mercator"
"tm"
"rso"
"stereo"
"lambert1"
"lambert2"
"nz"
"utm"

Spectra
Line indicator options are:
"same"
"calculate"


Height

followed by:
CRLF

Attributes list

"attributes”

Line number

Feature group name

Feature naming convention name
Feature correction

Feature type

and, for line or infill features:
Shot numbering convention name

plus, for default shot spacing type:

Default string
and, for infill features:
Associated line name

followed by:
CRLF

Project information

"project”

Project ID

Project name

Project start date
Project end date
Survey contractor
Media label

Media prepared

Date of issue

Client

Geophysical contractor
Positioning contractor
Processing contractor
CRLF

Current line information
If current line assigned.
"current"

Current line name
CRLF

NUMBER

STRING
NUMBER
STRING
STRING
NUMBER
STRING

STRING

STRING

STRING

STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING

STRING
STRING

(not followed by TAB)



Aim point information

"aimpoint"

Aim point name
Range (to aim point)
Bearing (to aim point)
Aim point type

CRLF

Run-in information

"runin”

Shotpoint units
Default run-in length
Lead-in start flag
Actual start flag
CRLF

GRS file name

llgrsll
File name
CRLF

Printing set-up information

"printing"

Current line printed
GRS printed

Lines printed
Stations printed
Obstacles printed
CRLF

Related Information

¢ TYPICAL OPERATIONAL FLOW OF THE LMN

¢ LMN TASK LIST

STRING
STRING
NUMBER
NUMBER
NUMBER

STRING

NUMBER
NUMBER
NUMBER
NUMBER

STRING
STRING

STRING

NUMBER
NUMBER
NUMBER
NUMBER
NUMBER



BACKGROUND INFORMATION: HISTORICAL GEODESY

The requirement to map the information obtained during a particular
survey, and allow return to that same location means that position is
a very important factor in seismic surveying. Measurements are
taken at or near the surface of the earth and therefore an adequate
definition of this body is required.

History

Spherical Earth Models

The first methodical measurement of the size of the earth was
undertaken by Eratosthenes (276-195BC), an Alexandrian scientist
who concluded a value of 6267km for the radius of a spherical earth
based on the shadow cast by a staff at two locations on the same
meridian (line of constant longitude). This differs by only about 2%
from the current accepted radius for a mean spherical earth, a result
which may be attributed more to luck than good judgement since a
number of false assumptions were made in the calculations.

Ellipsoidal Earth Models

Isaac Newton (1643-1727) and Christian Huygens (1629-1695)
developed earth models flattened at the poles after an increase in
gravity nearer with increasing latitude had been inferred from the
variation of the oscillations of a pendulum.

Thus the earth was now considered to have the properties of an
oblate spheroid, the solid shape described on rotating an ellipse
around its minor axis.

The Geoid

Amongst others, Laplace, Gauss, and Bessel recognised in the early
nineteenth century that even an ellipsoidal earth model produces
contradictions to physical measurements of the local plumb line (a
measure of the local direction of gravity) when compared to the
ellipsoidal normal. This deflection of the vertical was initially treated
as a random observational error in adjustments of arc measurements.
F.R. Helmert (1843-1917) was the first to directly utilise these




deflections as observations to be taken into account in the
determination of the shape and size of the geoid.

Related Information
¢ BACKGROUND INFORMATION: THE SHAPE OF THE EARTH

¢ BACKGROUND INFORMATION: GEODETIC DATUMS AND
COORDINATE SYSTEMS

¢ BACKGROUND INFORMATION: TIME
¢ BACKGROUND INFORMATION: MAP PROJECTIONS

¢ BACKGROUND INFORMATION: BIBLIOGRAPHY AND OTHER
RESOURCES



BACKGROUND INFORMATION: THE SHAPE OF THE EARTH

Definition of the shape of the earth is an important task for the placing
of spatial observations.

Geoid

If the waters of the ocean are considered a free-moving,
homogeneous body, then at a state of equilibrium, and subject only to
the gravity field of the earth, such a body assumes a patrticular level
surface of that gravity field. If this equipotential surface is imagined
extended under the continents, then we have defined the geoid. A
simple interpretation of this is that the geoid is that equipotential
surface which coincides, on average, with mean sea level.

Since the shape and size of this body is a function of the earth's
gravity field, then variations in this field lead to discontinuities in the
curvature of the geoid itself. Thus, this body is not a suitable
reference surface for position determination. Nonetheless, it is a
physically measurable surface, and useful particularly in the
deduction of height of a point.

Spheroid

The earth itself may be thought of as an oblate spheroid (i.e. flattened
at the poles). The size and shape of this spheroid are then important
parameters in the definition of the reference surface. The size and
shape of an ellipsoid are usually defined through the semi-major axis
(a) and the inverse flattening (1/f) respectively.




a = semi majnr axis
b = semi minor axis

f = (a-b)/a

Typical values for these parameters are:

a =6378137m, and

1/f = 298.257223563

(values are for the WGS-84 ellipsoid, a part of the WGS-84 datum)

One other important spheroid parameter is the eccentricity, which
may be obtained from the quoted values of a and f and the calculated
value of b. The (first) eccentricity of a spheroid is obtained from the
values of the semi-major and semi-minor axes:

a? - b

&

==

A related value, known as the second eccentricity, is found from:

Whilst at first glance it might appear most obvious to describe a
spheroid by its semi-major and semi-minor axes values, the format is
generally not used since the values are very susceptible to
interchange, being so alike. For similar reasons, the value of e,
which is useful in many calculations, is left for computation by the
user since its value (approximately 0.0067) is again easily wrongly



transcribed. Conversely, the inverse flattening is close to 300 in
magnitude, and false transcription is therefore readily spotted since it
Is of easily remembered magnitude. For this reason, the values
quoted in the description of a spheroid are most usually a and f.

Many other spheroids have been computed, the parameters created
such that a best fit is afforded for the area of interest. A list of these
spheroids is available in the reference Geodesy for the Layman noted
in the Bibliography.

Related Information
¢ BACKGROUND INFORMATION: HISTORICAL GEODESY

¢ BACKGROUND INFORMATION: GEODETIC DATUMS AND
COORDINATE SYSTEMS

¢ BACKGROUND INFORMATION: TIME
¢ BACKGROUND INFORMATION: MAP PROJECTIONS

¢ BACKGROUND INFORMATION: BIBLIOGRAPHY AND OTHER
RESOURCES



BACKGROUND INFORMATION: GEODETIC DATUMS AND
COORDINATE SYSTEMS

In seismic navigation, our interest in geodesy lies in the ability to
assign measurements (shot points etc) to a particular position. In
order to do this, we must have some body to which measurements
can be referred. This involves coordinate systems and the related
subject of geodetic datums.

Datum

A geodetic datum defines the reference system that describes the
shape and size of the earth. The coordinates of a particular position
are related to a particular datum, be that a local flat plane, or a
complex global system.

Any geodetic datum (other than a local flat plane) requires as part of
its definition some reference ellipsoid which mathematically
approximates the size and shape of the earth (see BACKGROUND
INFORMATION: THE SHAPE OF THE EARTH). This is chosen so
as to best approximate the surface of the earth in the area of interest,
be that local, regional, or global.

A datum may be horizontal (defining horizontal position), vertical (a
basis for the definition of height) or three-dimensional.

Transformation between different datums is often a task which must
be undertaken when working in large areas (where the local datum
may change), or when a client requires coordinate information
referenced to a particular datum. If both datums involved are well
known, then transformation parameters can be defined, usually by
way of three translations (along the x, y, and z axes), three rotations
(around each of these axes), and a scale change. Lists of the
required parameters are also available for many common
translations, particularly for the more commonly used datums (see
the WGS-84 reference in the Bibliography).

A number of ad hoc conversion systems exist which are important in
marine navigation. NADCON is a conversion routine specifically for




converting between the NAD27 and NAD83 horizontal datums used
in the United States, and also to high precision state systems.

A second important datum transformation system that has been
implemented in CSL software is the Statens Kartverk, the Norwegian
national mapping agency. This allows transformation between
various national realisations of the European Datum of 1950 (ED50)
and WGS-84 and is optimised for use in the North Sea.

Coordinate Systems

Coordinate systems come in a number of different formats, the choice
being dependent on the particular application at hand.

Cartesian Coordinates

Familiar rectangular coordinates used in mathematics are also
utilised in geodesy, particularly when describing satellite positions. A
three-dimensional Cartesian (X, y, z) earth fixed system defines a
fundamental terrestrial coordinate system. Origin is given as the
centre of the earth's mass (the geocentre, a position which cannot be
defined precisely and may be different for different datums,
dependant on it's empirical definition), and the z-axis is defined to
coincide with the mean rotational axis® of the earth. The xy plane is
described by the mean equatorial plane perpendicular to the z-axis,
and the direction of x passes through the mean meridian plane at
Greenwich. The y-axis is directed so as to form a right handed
system, i.e. it is located 90 degrees east of Greenwich. This
coordinate system is known as the Conventional Terrestrial System
(CTS).

Although it is easy to compute distances between pairs of Cartesian
coordinates, their usefulness diminishes when navigating a course
over the surface of the earth - a 'straight' line from Edinburgh to New
York would, because of the curvature of the Earth, pass under the
floor of the Atlantic, reaching a maximum depth of 1200km, and
would be 500km shorter than the shortest route on the surface.

Geographic Coordinates
The most usual system for describing vessel position is that of
latitude, longitude, and height. It is most usual for geographic



(geodetic) latitude and longitude to be referred to the equator and
Greenwich meridian as their respective origins. The illustration below
describes the relationship of these parameters.

P{g.4)

Reference
meridian

Equator

Latitude (¢) is therefore the angle between the equatorial plane and
the line describing the normal to the ellipsoid at point P. Longitude
(A) is the angle between some reference meridian (usually that
through Greenwich, although others such as those through Paris and
Jakarta have been used in the past) and the meridian passing
through P. Longitude is usually defined positive east of Greenwich,
and negative to the west, although not exclusively. Similarly, positive
latitude usually signifies a position to the north of the equator,
negative to the south.

The third coordinate in this system is height. Height must be
referenced with relation to some vertical datum, often taken as mean
sea level. Such heights are referred to as orthometric heights. It is
also common to be faced with spheroidal heights, where the locally
used spheroid parameters define a zero height. Orthometric and
spheroidal heights are very rarely the same, and often vary by tens of
metres (this difference is known as the geoid-spheroid separation). It
Is therefore important to know what type of height is given or
required.
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BACKGROUND INFORMATION: TIME

Time is an important concept in positioning and its definition is closely
related to the science of geodesy. A number of different time
systems may be encountered - the following gives an introduction to
the most important.

International Atomic Time (TAI) is that kept by a series of atomic
clocks spread around the globe. It was defined to be equal to
Universal Time at midnight, January 1%, 1958, and is a continuous
time scale (i.e. with no jumps).

Prior to the advent of atomic clocks, the rotation rate of the earth had
been used as timekeeper. Sidereal time is based on the apparent
motion of the stars (or a particular point on the celestial sphere at
least) due to the rotation of the earth. Greenwich Apparent Sidereal
Time (GAST) is a particular realisation of sidereal time, based on
observations at the meridian running through Greenwich.

Universal Time (UTO - be careful not to confuse with UTC, they are
not the same!) is based on the apparent motion of a mean sun (the
true motion of the sun is non-uniform) around the equator. On
correction for polar motion this time scale is known as UT1. UT1l is
therefore the time scale associated with the CTS (the z-axis of this
system is defined to be the mean rotational axis). Variations in the
position of the rotational axis of the earth were touched upon in the
previous section. As well as this polar motion there is also a definite
variation in the speed of this rotation; a general statement being that
the rate of earth spin is slowing over time due to the breaking effect of
the tides. A deviation between UT1 and TAl is observable due to this
slowing and it is for this reason that leap seconds are introduced
periodically to Coordinated Universal Time (known by its French
acronym of UTC). UTC is a civil time scale, defined such that its rate
Is equal to that of TAI, but kept roughly in line with the motion of the
sun by the application of these leap seconds.

Since the time system used in the Global Positioning System (GPS
Time) must be continuous for signal tracking reasons, there exists an
offset of an integer number of seconds between UTC and GPS time




(currently July 1997), GPS time is ahead of UTC by 12 seconds. A
summary of the relationships between the various time scales is
given by the US Naval Observatory:

"As of 1 July 1997,

TAl is ahead of UTC by 31 seconds.
TAl is ahead of GPS by 19 seconds.
GPS is ahead of UTC by 12 seconds."
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BACKGROUND INFORMATION: MAP PROJECTIONS

The earth is a three-dimensional, approximately spheroidal shape
upon which measurements (including those for seismic navigation)
are made. A piece of paper or a computer screen upon which we
wish to represent this spatial data is flat and two-dimensional.
Therefore, in order to resolve the above two statements, some
method of transforming the real world data to a format that may be
plotted or displayed is required.

Transforming from the three-dimensional world to a two-dimensional
chart is going to result in some distortion. The level of distortion is a
measure of the suitability of a particular map projection for the
charting process in hand, taking into account the area of coverage
and the purpose for which the map or chart is to be used. It must be
appreciated that no projection is completely free of distortion - it is the
cartographer's task to choose a projection which exhibits those
properties considered advantageous for that particular application.

Classification of Map Projections

Map projections are often classified according to the method by which
they are obtained or the properties they are designed to maintain.
Classification according to the geometrical figure used as the
projection surface provides the following general categories.

Cylindrical - If the map sheet is imagined rolled into a cylinder, and

wrapped around the globe, then projection of the earth's surface to
the map sheet will result in a cylindrical projection.

Y




Conical - In this case, the map sheet is a cone, and the earth surface
projected to this figure.

Azimuthal - The mapping sheet is a flat plane.

T

In each of the above scenarios, the projection figure (cylinder, cone,
plane) may touch the globe at a point or along a single line (the
projection is known as tangential), and distortion will increase away
from this line or point. Alternatively, the figure may ‘cut’ through the
globe, and touch its surface along a pair of lines (a single circle or
ellipse in the case of an azimuthal projection), in which case we have
what is known as a secant projection.
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Since the area of minimum distortion is that closest to the intersection
of the globe and projection figure, then a secant projection will
provide a comparatively larger area of such minimum distortion. The
choice depends on the size of area to be mapped - secant projections
are often used to map continental areas.

The particular properties of a projection are also a function of the
location of the imaginary light source used to 'project’ the earth
surface to the map sheet.

Another variant in the definition of map projections is the orientation
of the projection figure itself. Besides the usual orientation of the
cylinder, the cylinder may be made transverse (at 90 degrees to its
present position) or oblique (any angle between). The same
generally applies to the conic and azimuthal projections - the cone or
plane can be located at any location on the globe. The purpose of
these shifts in aspect is to orient the zone of minimum distortion such
that it coincides with the area of interest.

Properties of Map Projections

Every projection maintains a different set of properties of the area to
be mapped. The following is an outline of the desirable
characteristics to be preserved (remember that no map can exhibit all
of these - the perfect map projection is impossible).

Area - a map projection in which the area of a particular region is
conserved is know as equal area. This is advantageous for mapping
of relative properties of areas (e.g. population density).

Distance - A projection in which the distance between any pair of
points is conserved is known as equidistant. This is a highly
desirable property in applications such as route planning in aerial
navigation. Indeed, most aeronautical charts are equidistant.

Angle - If the azimuths measured on the map are equal to those
which would be measured in the real world, then directions may be
said to be preserved.



Conformality - If the scale in any direction from any point on a map
IS constant then the projection used is known as conformal (or
sometimes orthomorphic). A conformal projection also has the
property of conserving shapes over small areas. The most famous
example of a conformal projection is the Mercator projection, often
used in marine navigation since a straight line on the map equates to
a line of constant bearing (loxodrome) in the real world. The
disadvantages of the Mercator projection are highlighted in the
Mercator World Map, where the extreme northern and southern
latitudes are greatly expanded, leading to a false impression of the
size of areas such as northern Canada and Greenland.

Map Lines, Great Circles and Loxodromes

If a ship's captain requires to sail from point A to point B, the map
projection which has been used to produce the chart is an important
consideration. A line of constant bearing will not necessarily plot as a
straight line on the chart.

A Great Circle is a line describing the shortest distance between two
points on the surface of a sphere. Since the shortest route is (often)
the most efficient, aircraft tend to follow great circle routes. This is
the reason that an aircraft flying from Europe to North America will
often fly over Iceland and Greenland, and a flight from Europe to
Japan will fly over the North Pole - these are the shortest routes,
even though they may not look the most intuitive from simple
inspection of a map. If, however, you were to inspect a globe, or a
map produced with a gnomic projection (one in which great circles
are straight lines) then the route taken would appear more obvious.

We have therefore come across one of the aspects of map making
and map use which must be considered for navigation. What does a
straight line drawn on a map (a map-line) mean in the real world?
And conversely, how is a constant course followed on the surface of
the earth represented in a particular map projection? Different
projections will cause different types of distortion to the course
navigated. By choosing a projection in which great circle distances
are straight lines, we preclude the map's ability to represent lines of
constant bearing as straight lines also. You should therefore be



aware that a straight line drawn on one map projection is probably not
a straight line on another.

Examples of Map Projections

The following is a list of some of the more commonly used map
projections, together with an outline of their properties, and typical
usage.

Mercator

The Mercator projection is conformal and has the property of
retaining straight lines of constant compass bearing. Parallels and
meridians (lines of constant latitude and longitude respectively) cross
at right angles. Scale is true along the Equator, or along any two
parallels equidistant from the Equator.

A variant of this projection, the Universal Transverse Mercator (UTM)
Is used widely for mapping at medium scales on a national level. The
UTM minimises distortion by splitting the globe into bands of 6
degrees of longitude and defining a transversely located cylinder for
the projection at the centre of each band.

Albers

Albers is an equal area conic projection and as such preserves the
proportion of any area mapped in relation to its real world basis. This
projection is widely used for mapping in large countries with a larger
east west than north south extent (e.g. United States).

Stereographic

Used for navigation in polar areas since directions are true from its
centre point. This is an azimuthal projection in which scale increases
away from the centre, as does distortion in area and shape. The
Universal Polar Stereographic (UPS) projection is often used for high
latitude mapping (above 84 degrees north and 80 degrees south).

Lamberts Conformal Conic

As its name suggests, this projection is conformal, and is based on a
conical projection figure. This projection exists in tangential and
secant form, i.e. with either one or two standard parallels. Since the
zone of minimum distortion surrounds the standard parallel, then area



and shape are distorted away from the standard parallel(s) but
directions are true for limited areas.

Parallels are unequally spaced arcs of concentric circles, more
closely spaced near the centre of the map. Meridians are equally
spaced radii of the same circles, thereby cutting parallels at right
angles. Scale is true along the standard parallel(s). The pole in the
same hemisphere as the standard parallels is a point, while the other
pole is at infinity. Used for maps of countries and regions with
predominant east-west expanse.

Polyconic

This is a projection widely used in the past for USGS mapping
(United States Geological Survey - essentially the national mapping
agency in the United States until recently). Based on an infinite
number of cones tangent to an infinite number of parallels, scale is
true along each parallel and the central meridian. The central
meridian is straight, all others are complex curves. This projection is
rarely used today.

Rectified Skew Orthomorphic

Belonging to the conformal family of projections, the Rectified Skew
Orthomorphic displays the property of constant scale in any direction
from any point. This is the general projection of which the Mercator
and Transverse Mercator are special cases. Any great circle may be
used as the transverse equator, and for this reason the projection is
often used for countries with an oblique long axis.

Cassini

Devised by C.F. Cassini de Thury in 1745 for the survey of France,
and modified by Soldner in 1810 (sometimes called the Cassini-
Soldner projection for this reason), this is a cylindrical projection
which is neither equal-area or conformal. The central meridian, each
meridian 90 degrees from that central meridian, and the Equator are
straight lines. All other meridians and parallels are complex curves.
Scale is true along the central meridian, and along lines
perpendicular to central meridian. Scale is constant but not true
along lines parallel to central meridian on spherical form, nearly so for
ellipsoid. This projection was used for mapping the UK in the past,
and is still used in some areas of the world.



Kavraisky

A conical projection with minimum linear distortion. This projection is
constructed using two true-scale parallels, and is primarily used in the
mapping of moderate to high latitude areas.

New Zealand Map Grid

The New Zealand Map Grid (NZMG) is a projection used to convert
latitudes and longitudes on the New Zealand Geodetic Datum 1949
(NZGD49) to eastings and northings used for the mapping of New
Zealand. The purpose of this projection system is to minimise scale
error over New Zealand specifically, and therefore cannot be sensibly
used elsewhere.

Project Definition

In order for a particular projection to be adequately defined
mathematically, a number of parameters must be provided. Typically
this involves the definition of the standard parallel or meridian, the
latitude and longitude of the projection origin, and the scale factor at
that origin. Other parameters may be required for some projections,
dependant on the complexity of that projection. Some, like the New
Zealand Map Grid, are defined using specific polynomials.

Map Grids and Graticules

Printed onto may maps and charts are tick lines or a grid. The
coordinates of a particular location can be simply read off the map by
use of these markings.

A graticule is the projection of the three-dimensional lines of latitude
and longitude onto the flat surface of the map. Therefore, the
graticule is often not a pattern of perpendicular lines (dependant on
the projection).

A grid, however, is some arbitrary rectangular system overlaid onto
the map projection to provide a suitable coordinate reference system.
A prime example of this is the UK National Grid, defined so that
Ordnance Survey maps can easily be used to define a unique
position of any point in the British Isles. The origin of the National
Grid is located to the west of the Scilly Isles such that grid



coordinates are always positive, and the coordinates thus defined are
known as Eastings and Northings.
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Internet Resources

Further information on map projections can be found at the following
tmjtlt:zpl?lsl\./vvxm.utexas.edu/depts/grg/gcraft/notes/mapproj/mapproj.html
(r)]trtp:llwww.uncc.edu/~|agaro/cwg/mapproj/index.htmI
Etrtp://www.uidaho.edu/~huber921/map/

Information on coordinate systems:
http://www.utexas.edu/depts/grg/gcraft/notes/coordsys/coordsys.html

Information on geodetic datums:
http://www.utexas.edu/depts/grg/gcraft/notes/datum/datum.html

Information on time, specifically as it regards GPS:
http//tycho.usno.navy.mil/time.html

The US National Imagery and Mapping Agency (an umbrella
organisation, bringing together, amongst others, the Defence
Mapping Agency (DMA) and the US Geological Service (USGS)
Mapping Division:

http://www.nima.mil/

The Marine Navigation Home Page:
http://164.214.2.59/Navigation/index-frs.html

Geodesy for the Layman, a Department of Defence publication, now
available at:
http://164.214.2.59/geospatial/products/GandG/geolay/toc.html

Publications

Torge, Wolfgang (1991). Geodesy, 2™ Ed., De Gruyter.
A rather complex and mathematical approach to the definition of geodesy and
the geoid.




Vanicek, Petr and Edward Krakiwsky. Geodesy: The Concepts
Regarded by many as the 'bible' of geodesy, written by two of the most respected
in the field.

Snyder, John P. (1987). Map Projections - A Working Manual, US

Geological Survey.
A definitive work, covering the concepts, principles and modern techniques.

Defence Mapping Agency (1991) World Geodetic System 1984: Its
Definition and Relationships with Local Geodetic Systems, TR8350.2,

DMA.
The US DoD Mapping Agency report on WGS84, the global datum used for
computations in the GPS system.

Bock, Yehuda (1995). "Reference Systems" In GPS for Geodesy,
Eds. Alferd Kleusberg and Peter Teunissen, Netherlands Geodetic
Commission.

One chapter of a good technical reference for (mainly) static geodetic
techniques. Still, it has much of interest to the wider GPS community.

Parkinson, Bradford and J.J. Spilker Jr. (1996) Global Positioning

System: Theory and Applications

A comprehensive guide to GPS, from its initial design and implementation to the
latest techniques and applications. Contains some information on reference
systems and time as they are applied to GPS.

Statens Karverk (1990) The Transformation between ED50 and

WGSB84 for Exploration Purposes in the North Sea.
A short paper on the datum transformation system agreed on between Denmark,
Germany, the UK, the Netherlands and Norway.

Featherstone, Will and R.B. Langley (1997) Coordinates and Datums

and Maps! Oh My! Innovations column, GPS World, January 1997.
An accessible summary of the problems associated with the carious maps and
datums used in GPS.
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